Introduction to Pagemaker 7.0

INTRODUCTION

Adobe PageMaker 7.0 is the “world’s leading cross- platform professional page

layout software”. PageMaker is primarily used for designing and producing publication that
requires a combination of text and graphics. PageMaker 7.0 has a rich array of facilities to
import text and artwork from other computer application packages, as well as allowing you to
generate these directly form within PageMaker itself. PageMaker can handle text better than
[lustrator and PhotoShop and also give you the flexibility of graphic control not available in
world processors

NEW FEATURES IN PAGEMAKER 7.0

DOCUMENT LAYERS

Layers allow you to place elements on over the other. It can be thought of as
sheets stacked up one on top of the other. You can place elements on these layers or temporarily
hide the layers. These layers can be used for adding imitations, floating or background images.

EASIER LAYOUT

There is a new concept of frames in PageMaker 7.0, which can hold any type of
text or images. PageMaker’s freeform layout capabilities have become even more flexible with
its frame and text controls.

BETTER INTERGRATION

PageMaker can work seamlessly with PhotoShop, Illustrator etc. It also builds the
ability to drag and drop images and elements directly from one of these applications to the other

COLOR CONTROLS

PageMaker 7.0 introduces new color technologies, which helps in reproducing
high fidelity colors in you publications. A new desktop color separation tool is also included.
The Kodak color management system now supports the international Consortium of Standard
for sharing device profiles.

INTERNET READY



The current release of PageMaker (i.e. Version 7.0) includes an option to export
your PageMaker documents to Internet ready HTML (Hyper Text Markup Language) files with
the links preserved. The document images are converted to GIF or JPEG format required by the

Basic of Pagemaker

PAPER ORIENTATION

You can set paper in two ways, portrait is one in which the paper is used with the
longer size in the vertical direction. If we interchange the directions, we get the Landscape
orientation.

Lands cape

STARTING PAGEMAKER

Click the Start button.

Select Programs.

From the Programs Menu select Adobe.
In the Adobe Menu select PageMaker 7.0.
Click adobe PageMaker 7.0.

The PageMaker window is displayed.

PAGEMAKER ENVIRONMENT

Menu Bar:



The standard menu bar contains all the main menus for File, Layout, Element and
other utilities.

Ruler:
The top and left ruler bars helps you to precisely position the cursor, text, and

graphics in the page. The Current Cursor location is shown by two dotted lines in the rulers. The
view the rulers select View > Show Rulers.

Master Page Icon:
The Master Page icon showed the position of the master Pages. Clicking it will

display the Master Page. Master Pages contain text, graphics, layout and settings, which are
common, thought the publication.

Page Icon:

The Page icon shows the list of pages in the publication with the currently selected
pages in black. Clicking a particular page icon will display the selected page.

Plasterboard:

Surrounding the page is an area of white space called the Plasterboard. It is used to
store graphics and texts as you work. Items you place on the plasterboard are visible from any
page and can be selected and moved regardless of the page you are currently working on.

Rulers

Pasteboard

Master Page Icons |

Page lcons




FILE MENU

New: New command is used to create a new publication. This command gives
rise to a dialog box where you define the various options before opening a new page of the
publication.

Open: Open allow you to open an existing PageMaker file.

Save: Save command saves the current publication. To save all the open files,
press the shift key while choosing the Save option.

Revert: Revert command rolls back all the changes made since the last save. It is
the same as closing the publishing without saving and opening it again.

Place: Place command is used to place text and graphics into the publication.
Acquire: The Acquire command is used to scan an image into your publication.

Export: Export command lets you export you publications into the format you

select.
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EDIT MENU
Paste Multiple: Paste Multiple lets you paste multiple copies of text or
graphics.

Paste Special: Paste Special is used to specify the format to use when you paste
an object into your publication.



Insert Object: Insert Object is used to specify the format to be used to insert an
OLE embedded object within a PageMaker publication.

Edit Story: Edit Story is used to toggle between the word processing mode and
the layout mode.

Edlit Meru

LAYOUT MENU

Sort Pages: When you select Sort Page command, a dialog box appears with all
the pages of the publication. You can rearrange the pages in the publication graphically.

Column Guides: Column Guides lets you divide the pages of the publication

into different column of equal size.

Auto Flow: Auto Flow is used to flow the text onto the pages of the publication
on its own from a loaded text icon. It flows the text into pages from columns to columns and
also adds pages on its own depending on the availability of text.

m Layout Menu
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TYPE MENU

Define Styles: This option will present you a dialog box with the list of styles
used in the publication. You can add, modify and delete styles from this dialog box.

Fank »
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ELEMENT MENU

Frame: Frame has options for frame alignment, position and margins.

Align Objects: Align Objects lets you align multiple objects relative to each
other.

Link Options: Link Options is used to define whether the linked text or graphic
is to be updated along with the publication in use and also its frequency.

Element henu

Fill

Skroke -
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Link Options. ..

UTILTIES MENU



Plug-ins: Plug-ins has a list of sub commands, which lists out the various plug-
ins, which have been included with PageMaker as additions.

Uilities Manu

Acd contdine...
EBalance Columns. ..
Build Booklet. ..

Bullets and numbering. ..
Change Case...
Create Color Library...

Eook. .. Drop cap. ..

Index Entry... Y EF3 Font Scanner...
Show Index. .. Global Link Options..,
Create Index... Grid Manager ...
Create TOC, ., Eeyline...

Publication Coreeerter...
QuickTime Media. ..
Running Headers & Footers. ..

Define Colors. ..

Save For Service Provider. ..
Word Counter

VIEW MENU

Display Master Items: Display Master Items toggle the display of items from
the master pages to be reflected in the current page of the publication.

Display Non-Printing Items: Display Non-Printing items toggle the display
of non-printing items.
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WINDOW MENU

Show Tools: Hide/Show tools toggles the display of PageMaker toolbar.

Show Control Palette: Show/Hide Control Panel toggles the display of
control panel on the screen.

Show Colors: Show/Hide Colors Toggles the display of the Color Palette on the
screen.



Show Style: Show/Hide Styles toggles the display of the Styles Palette on the
screen.

Show Layers: Show/Hide Layers toggles the display of the Layers Palette on the
screen.

Show Master Pages: Show/Hide Master Pages toggle the display of the Master
Pages Palette on the screen.

Show Hyperlinks: Show/Hide Hyperlinks toggles the display of the Hyperlink
Palette on the screen
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UNDERSTANDING PAGEMAKER TOOLS

TOOL BOX

Toolbox contains all the tools used to create a publication in PageMaker. Choose
Window and select Show Tools to display the toolbox. The individual tools will be explained in
detail later in this session.
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ZERO POSITION

Zero Position allows you to set the zero position on the screen. Zero position is the
position, where both the top and the left side rules are at zero. By Zero positioning all
measurements in the pages are made relative to this point. Click it and drag it to anywhere on
the workspace to set it as the Zero Point.
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POINTER TOOL

Pointer tool is used to pick, drag and drop graphics and text.

TEXT TOOL

Text Tool is used to edit and select text and insert text frames. Click the text tool
and click anywhere in the document and start entering text. The text tool creating a free flowing
text box.

ROTATE TOOL

Rotate too is used to rotate text and graphic objects. Click the rotate tool. Then
click on the object reference point and drag to rotate the object.
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CROP TOOL

The Crop tool is used to crop imported graphic images to the required size. The
crop tool only works on TIFF type of images. Click on the toll and, drag the image handles, to
crop the image.
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OBLIQUE LINE TOOL

Oblique Line is used to draw slanting lines. To draw a line, click the oblique line
tool, click and drag to draw a line in any direction.
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CONSTRAINED LINE TOOL

Constrained Line tool will draw lines at 45 degree intervals, i.e., horizontally,
vertically or diagonally.
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BOX TOOL

Box tool is used to draw a box.
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RESTANGLE FRAME

Rectangle Frame is used to type text inside a box. First select the toll and draw the
area to be enclosed by the rectangular frame, then select the text tool and click inside the drawn
frame to enter text. The text will be constrained to the rectangular frame.
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CIRCLE TOOL

Circle tool is used to draw a circle or elliptical graphic. To draw a circle or an
ellipse, select the tool, click and drag to draw a circle on the document.
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Circular Frame is used to type text inside a circle or an oval. Use the Circular
frame tool to draw the frame and then click inside with the text tool to start entering text. The
entered text will be constrained to the circular frame.
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POLYGON TOOL

Polygon tool is used to draw a shape with more than four sides. You can modify
the polygon by selecting Element and selecting Polygon Settings.
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POLYGON FRAME

Polygon frame puts the text inside the polygon. Select the polygon frame tool,
draw a polygon then select the text tool and click inside the frame to enter the text inside the
frame to enter the text inside the polygon frame.
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HAND TOOL

Hand tool is used to move the screen. This tool is very useful when you are
working with large documents. It helps you to easily navigate in a large page. To move a screen,
just select the hand tool and click and drag the page to view different parts of the page.
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Z00M TOOL

Zoom tool allows you to zoom in and out of the document view. By default the
zoom tool will be in the Zoom-in mode. To zoom out of page select the zoom tool and press
control and click in the document window with the zoom tool.
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OENING A NEW PUBLICATION
Click File.

Select New.
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The Document Setup dialog box appears. Enter 2 in the number of pages text box
and press the TAB key.

& Adobe PageMaker 6.5

File Edit Layout Type Element Utilities iew Window Help

Document Setup 0K,

Page size: I 'i Cancel
Dimenszions: I8.5 b I‘I‘I inches

Driertation: © Tall " Wide

Mumbers...

Options: W D auble-sided ™ st Iyt
¥ Facing pages I Restart page numbering

Mumber of pages: |2 Start page #: I1

—Marging

Inside: |D.?5 inches Outside: ID.?S inches
Top: |D.?5 inches Bottom: lD.?E inches

Target output resolution: | 300 | dpi

Compose to printer: I FOISPLAY on Mon j

Enter 1 inch as the inside margin and press the TAB key.
Select the printer “HP Deskjet on LPT1”

Click OK.

A new document is opened with the required margins and the first page of the
selected document is display
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File Edit Layout Twpe Element Ukilities

16



PAGE SIZE AND PAPER SIZE

Paper size is the actual size of the paper and Page Size is the printable area of the
page. The Page size is the area enclosed by the page margins.

CONTROL PALETTE

The control Palette displays the properties for the selected paragraph, character or
object. It is a sort of shortcut to the object, text, and paragraph properties. Choose Window and
select Show Control Palette to display the Control palette.
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Control Palette in Object Mode

The control Palette when it has an object selected displays the object properties
such as the reference point, position, size, scaling. Cropping, printer resolution, rotating,
skewing and horizontal and vertical reflection.

Horizontal/vertical mirror: Mirrors the currently selected object along the x
or y-axis.

Height/width: sets the height and width of the currently selected object, either

numerically in inches or in percentage of the current size.

Rotate: Rotate, is used to rotate the selected object around an axis. The center of
rotation is set as the object’s center and exact measurements can be used.

Skew: This skews. The currently selected object, in degrees.

XY position: sets the horizontal and vertical position of the upper-left comer of
the currently selected object.

|E| [+ [5.547 in__ | [M'w(3.395 in__ [100% I & 0 F+1
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Control Palette in Character Mode

The Character Palette is displayed when the text tool is selected. It has options for
changing text styles, size, leading, tracking, width and Deming. There is a toggle button to shift
between paragraph view and character view.
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Kerning: Text Kerning adjusts the spacing between characters in text. It is
selective, so you can adjust just one or two characters, or whole sections of text, Negative
numbers move characters closer together, whereas Positive numbers space them out.

Leading: Text Leading adjusts the spacing between lines of text. This is
applicable on line-by-line basis. Positive and Negative number have the same effect as they have
on Kerning, except that the spacing is between the lines of text.

Tracking: Text Tracking adjusts how closely characters follow each other. Very
tight tracking brings text closer together, very loose spreads it out a bit.

Size: Text Size adjusts point size of text.

Position: Text Position adjusts the placement of the text on a given line. Positive
Numbers move the text into a super text position (above the line), and Negative numbers move
it into a subtext position (below the line).

Width: Text Width adjusts the character width and does not affect height. The

larger the percentage, the wider the word. Percentages over 100% make it proportionate larger
than standard sizing, fewer than 100% make it proportionate smaller.

Control Palette In Paragraph mode
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The control palette displays options for the paragraph style, alignment, indents,
spacing, grid spacing and grid alignment.
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COLOR PALETTE

The Color Palette is used to apply colors or view the name or kind of color applied
to the selected text or object. The buttons stroke, fill or both, can be used to change the color of
the graphic object and Object level. Tints allow you to have variations of the same color. To
apply a color to a text or object and select the color from the color Palette. Choose Window and
select Show Colors, to display the Colors palette.
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STYLES PALETTE

The Styles Palette is used to apply styles or to view or edit styles defined for the
publication. To apply a style, just click a paragraph with the text tool and then click a style name
in the palette. Choose Window and select Show Styles to display the Styles palette.

Body text
Caption
Hanging indent
Headline
Subhead 1

| Subhead 2

=]
4

=

LAYERS PALETTE

The Layers Palette is used where a multiple layers document structure is required.
Layers allow you to separ4ate the different elements that make up your document. You can hide,
display, add or delete layers as required. Choose Window and select Show Layers to display the

Layers Palette.
C1x]
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(W Laers
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2
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W Layer 2

W [Default]

Layer 5 targeted B | T
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MASTER PAGES PALETTE

The Masters. It displays a list of available master and apply masters pages for a
particular document. The master page icon at the bottom of the window is used when you want
to go to a master page for editing. Choose Window and select Show Master Pages to display the
master Page palette

Layars 1 Master Pages ™, 4

0

(] v

Editing Master Page BT

HYPERLINK PALETTE

A hyperlink has two parts: a source, which is the hyper linked text, or graphic that
you click, and a destination, which is where the source jumps. Inside a PageMaker Publication,
destinations are called anchors. You can also give a valid web hyperlink. Choose Window and
select Show Hyperlinks to display the Hyperlinks palette.

Hyperlinks ™. 4

hittp: # F vy, adobe. comd 1
hittp: £ Famen, adabe. comd 2

LRL Bl | m

SETTING A MEASUREMENT SYSTEM
Click File
Select Preference.

In the Preferences menu select general.
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GRIDS, RULERS AND GUIDES

GUIDES

Margin Guides: Margins are defined in the Document Setup dialog box, when
you first create a publication, and are applied to the Document Master page. These are
represented by pink lines on the top and bottom and by blue lines on the left and right.

Column Guides: Column guides serve as boundaries for text you place within
them. You can have as many as 20 column per page. Column guides control the flow of text and
represented by dark blue lines.

Ruler Guides: Ruler Guides are also nonprinting guidelines which primarily
used to align. Objects in the publication and are represented on the screen by Light blue lines.
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VIEWING PAGES

Zoom In: Zoom in Magnifies the Document to the next level
Zoom Out: Zoom out Shrinks the Document view the previous level

Actual Size: Actual size Displays the entire page or a two page spread within

the publication window.

Fit in Window: Fit in window will display the current page in its entirety
within the publication window. This view is especially useful to check the layout of the page.

Entire pasteboard: Entire pasteboard displays the page with the entire

pasteboard so that you can find or view objects.

v Display Master Trems
{ v Display Non-Printing Ttems Ak
Zoom In 4
Zaam Ok -
Aetual Size 1
v Fit in Window “
Entire Pasteboard sh~n

INSERTING PAGES
Click Layout.

Choose Insert Pages.
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SORTING PAGES
To change the page order Click Layout.
Select Sort Pages.

A dialog box with the page icons appears. Click on the fourth page, and place it
before the first page.

M Sort Pages

-

W] =T
P

Click OK to close the dialog box.

The Page is rearranged and the page numbers are changed accordingly.

CREATING NEW DOCUMENT

MASTER PAGES

Master Pages are a sort of a template for all of the pages in a publication. The
Master pages can contain text, Graphics and guides. These are reflected in all the pages of the
publication. They generally contain logos and volume title, which are to be repeated in every
page of the publication and also guides, which help to maintain uniformity throughout the
publication.

23



¥ Adabe PageMaker 6.5 - [Untitled-5]

Master Pages

S EEEE R
[ e | 3 5 R |

.+ /[
CREATING A NEW MASTER

Click Window.

Select the Show Master Pages Palette from the window menu.

In the Master Pages Pallet Click on the Top right arrow to display the Palette

Menu.
[ Lagos [ Master Pages™ ’
i [None] k
B ocament ] |
Applying Master Page B
Working with Text
TEXT BASICS
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ENTERING TEXT

In Page Maker, text is typed in text blocks or frames. Text blocks are defined by
the amount of text and the margins of the page.

To open a text block First click the Text tool.
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Click anywhere on the page within the margin guides.

Press the mouse button and drag the insertion point to the right. Release the
mouse when you have opened the box to the correct size.
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PLACING TEXT
Click on Edit menu.
Select Edit Story.
Type “Demo for Placing Tex “. Click on Story.

Select Close Story.

Page Maker displays an alert message that says, “The story has not been placed.”
Click the place button to place the story.

PageMaker

\1‘) Story has nat been placed

Pl | Decrd ‘ Corid ‘

Page Maker displays a loaded text icon. Click the icon to flow text into the frame
or column you click on.
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TEXT OBJECTS, STORIES AND EDITORS
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Understanding test objects and stories: Text in PageMaker is part of a
story. A story can be a single letter or several page of text and can be contained in a single text
object or threaded through many different objects.

Layout Editors and Story Editors: Text blocks that are threaded together
in the Layout Editor comprise the same story in the Story Editor. A text block may be split
among several pages in the Layout Editor, but it appears as a continuous story in the Story
Editor.

FORMATTING TEXT

Changing Font Sizes: In PageMaker, by default the type size is 12 points but
you can change the size as often as you like using the Control Palette. The Control Palette can
be activated or deactivated from the Window menu.

Changing Typeface Styles: There are ten different styles for any typeface.
They are Normal, Bold, Italic, and Underline, Reverse, and Strikethrough, Small caps, All caps,
Super script and Sub script.

Times New Roman [~ |ERIT [12 ¥ | w48 [No Track [+ |[0H &
NB[F[VRE[CICIZ[F]ER 14.4 [~ |EE X [100% [~ |ER % [0 in

Changing Character Specifications: The Character Specifications dialog
box allows you to choose several type attributes in one step. This dialog box can be opened by
double clicking the Text tool.

Character Specifications

Fant: |Tirnes Mew Roman j
Size; m points  Position; Im Cancel
Leading; m points  Case: Im :

Horiz scale: W 4 Track:  |Mohack = m
Color: ’m Line end: m

Tk [0 <z

Type sty | Momal ¥ Italic [ Reverse
[~ Bald [~ Underline [~ Stikethiu
KERNING AND TRACKING

PageMaker provides three types of kerning.



Automatic pair kerning: Automatic pair kerning adjusts the space between
certain character pairs, based on the kerning information that’s built into the font.

Manual kerning Manual: Kerning lets you kern any range of text, from one
character pair to a whole story, using cursor keys or by using the Control palette.

Expert kerning: Expert kerning calculates a manual kerning value for every
character pair in a selected range of text.

TRACKING

Tracking is similar to kerning in that it deals with the horizontal space between
letters. PageMaker includes five built-in tracks from Very Loose to Very Tight. To set the
required track, first select the text.

PARAGRAPH SETTING

Paragraph formatting includes setting indent values, paragraph spacing, text
alignment, dictionary, etc. in this exercise we shall see how to draw a line below a paragraph.
Click on the Text tool.

Select the Text paragraph.
Click on the Type menu.
Select Paragraph Options

Paragraph Specifications

Indents: Paragraph space:
Left o inches Eefore |01 inches Cancel
First |0 inches After u} inches

Rules. ..
Right |0 inches 4]
Spacing...

Alignment: | ustify - Dictionary: | US English =
Options:

[ Eeep lines together [~ Keepwithrest [g lines

[ Column break before ™ widow contral [ lines

[ Page break before ™ Orphan control - [ lines

I Include in table of contents

SETTING TABS

In this exercise we shall see how to set tabs.

Select the Text tool.
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Click on the Type menu.

Select Indents/Tabs.

Hl Indents/Tabs

Leader I

IN one Fezst i | (H]. I
| inches Apply I Cancel I

o - - . - L - o - o . o
E|||I|”I|||I|I2|||||I|I3II|||I|I4II|||I|I5|I|I|I|lI3|I|||I|?|I|||I|?|I|||I|?|I|I|I1|'Ij|I|||I1|”||||I1||2|I

Drag the first half of the left indent to 1 inch.

IndentsfTabs

Leader | !None

E] 'lault]
Reset ’

=
[B[T]/

|E . Pasition | i| inches Apply ’ Lancel ]

|I|T|I|T|I|I| """"""

g |0

ElEE

IE ! O]® -.-[Heqlstratlo_n]-
|E '&i ] 000100
E [

(L ik <|

T s

|
Leader | iN ane
Pasition | i‘ll inches

e K]

Apply | Cancel |
I_.

. [Reglstratlon]
Rooocioo  [B [T [~

I bl |

i >
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Click OK.

Thus the paragraph has been aligned according to the Indents set.

§5| Adobe PageMaker 6.5 - [Untitled-2]

This 15 alearning
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ﬂ canleam Fegetnale Default targeted Bl | i v
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BULLETS AND NUMBERING

THE Bullets and numbering option automatically adds bullets or numbers to the
paragraph in the text block. To edit bullets or to add numbers you can click the Edit or Numbers
button respectively.

Bullets and numbering 0K

Bullet style: Cancel

Mumbers

-
1T

Remove

Range:
" For next: paragraphs
" All those with style: | Body text L]l

" Every paragraph in story
(* Only selected paragraphs
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HYPHENATION SETTING

PageMaker hyphenates words to reduce the spacing between them in a justified
text. Hyphenation is controlled with the hyphenation dialog box.

The Manual only option hyphenates only the wordds that you have marked to
hyphenate by inserting a discretionary hyphen in the word where it would normally break.

Hyphenation §|

Hyphenation: @ On O OfF
* tanual anly Aﬂl

" Manual plus dictionan

" Manual plus algorithm Add.

Limit conzecutive hyphens bo: Mo lirit

Huphenation zone: ||:|_5 inches

Manual plus dictionary option hyphenates the words to which you have added
discretionary hyphens, as well as words hyphenated in the PageMaker dictionary.

Hyphenation

Huphenatiorn: & On O OfF
7 Manual only B

" b anual plus dictionary

£ Manual plus algorithm Add.

Limit conzecutive hyphens to: Mo linmik

Hyphenation zone: (0.5 inches

In addition to using the dictionary, Manual plus algorithm option, uses a
mathematical algorithm and your manually inserted hyphens to break words.

Hyphenation
Hyphenation: & Op O Off Ok

" Manual only Cancel

7 Manual plus dictionan

i,

* Manual plus algorithm add. !

Limit conzecutive hyphens to: Mo lirnit

Hyphenation zone: |05 inches F




Hyphenation Setting

Let use see how to add a word to the user dictionary. Click on the Type menu.

Select Hyphenation.

Click the Add button in the Hyphenation dialog box.

In the Add to User Dictionary dialog box type Lay~out~ Galaxy. In this word,
h\the most favorable break is marked by a single tilde (~) and the second most favorable break is
marked by a double tilde. Click OK to close the Add to User Dictionary dialog box.

Click OK to close the Hyphenation dialog box.

The word “LayoutGalaxy” has been added to the Dictionary.
SET STYLES

In this demo we shall see how set style
Select the Text tool.

Click the insertion point anywhere in the text.

CREATING STYLES

To create a new style click on the Type menu.
Select Define Styles.

In the Define Styles dialog box, Click New button.

Define Styles @

Style: ok

Body test Cancel
Caption

Hanging indent
Headline MNew...
Subhead 1
Subhead 2

Mo style + face: Times Mew Roman +
zize: 12 + leading: auto + fluzh left +
hyphenation

MG

Impart...

Style Options dialog box opens. In the Name text box type “MyStyle”.
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Style Options

Marne: iMiStyle Ok

Bazed on: [F.Icu style Cancel

sl

Mext style: ]Same style
Char...

nest: Same style + face: Times New
Roman + zize: 12 + leading: auto + flush Para...
left + hpphenation

Tabs...

Huyph...

ROTATING TEXT

Let us see how to rotate a text frame. Click the arrow tool.
Select the text

Type 45 degrees and press Enter.

The frame has been rotated by 45 degrees.
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ADDING COLOR TO TEXT

In this Exercise, we shall see how to change the color of a text.
Select the text.

Click on the Window menu.
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Select Show Colors.

_ baster Pages

O [Default]

. Dafaulk kargeted 1 | i} |

Stg]es ‘{ Colors ™. bk

i

. Elue HE] V
A1 Plates El i}

Select blue from the Colors Palette.

The Text Color has been changed to blue.

#3| Adobe PageMaker 6.5 - [Untitled- 4]
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ADVANCED TOPICS

CREATING HYPERLINKS

Let us create a hyperlink. Click on the File menu.

Select New.
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Document Setup dialog box opens. Click the Page Size Pop-up menu.

Document Setup

Page size: |Letter _'k
Dimensions: 185 % |1 inches

Drientation: © Tal 'wide

Humbers...

Options: v Double-sided [ Adjust layout
! | 1 : =
¥ Facing pages I~ Restart page numbering -J—I

Mumber of pages: ,1_ Start page #: 11 m"f”‘l

Margina ZI
Inzide: inches Outaide; |0.75 inches
A

Top: |0.75 inches Battor: |0.75 inches =

Target output resalution: {300 «| dpi Jll
Compose to printer: | L] ,1_

THREADING

When a story in a text block extends to the next or subsequent pages, it is broken
up into individual page text blocks. A small Red triangle in the lower window shade handle
indicates that there is more text that can be currently displayed in the text box. Click on the Red

triangle to display the second block of the text.

% Adobe PageMaker 6.5 - [Lintitled-4]

File Edit Layout Type Element LUtiities View ‘Window Help =
o 101 I TN T RTINS NT Y

o
agelvlaker lets wou view your
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ioms . A lternatively, you canuse
hezoon tool to specifir anare of
he page toview; and increase of
teciease its magnifiction at the
parne time. Tochagethe part to L
E

k

# [10.063 in
Y [-0.875 in

The pointer will turn into a loaded text icon. Click to place the second block. The
small + symbol in the top window shade indicates that the story has been continued form a
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previous block text. An empty handle in the bottom window shade indicates the end of the
Story.

| Adobe PageMaker 6.5 - [Untitled-4]
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SPELL CHECK

PageMaker helps you in proof-reading your text by providing a ‘Spelling
Checker’, which can be used to check the spelling for a selected range of text or for all the text
in the active story or all stories in all open publications. PageMaker will warn you of any words
it cannot locate in its dictionary. If any word is misspelled then you have the choice to re-enter it
or choose form a selection of closest matches in the dictionary. The spelling dialog box can be
activated from the Utilities menu.

W Spelling X
Change to: || | ‘—]
Add...
Options: [V Alternate spellings ¥ Show duplicates
Search document: (* Current publication " All publications
Search story: i O Cument story O All stories
WORKING WITH COLUMNS
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PageMaker allows you to divide any page into columns. In this exercise we shall
split a page into Columns. Click on the Layout menu.

Select Column Guides.

A Columns Guide dialog box appears. In the Number of columns dialog box, type

2.
Column Guides ['E
Humber of columng; |2
A Cancel
Space between columng: |E1|3?_ inches
[ Adiuzt lapout
Click OK to close the dialog box.
We can now see the pages split into columns.
£ Adobe PageMaker, 6.5 - [Untitled-1] = (B
Fil= Edit Lavout Twpe Element Utiities View ‘Window Help =I5
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INDEXES AND PAGINATION

To create an Index, Click on the Edit menu.

Select Edit Story.
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Create Index [5_(|

Title: |_|:u;t J
[ Ry = - Cancel

=

Iv Remove unieferenced topics Format...

[ Include entries on hidden layers

Click the loaded text icon anywhere on the page. Now you have added, “adjust
layout” to your Index. Similarly you can add other words.

¥/ Adobe PageMaker 6.5 - [Untitled-1]
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INDEXES AND PAGINATION

The Sort Page feature can be activated from the Layout menu. This feature allows
you to re-order the pages in your document. This can be easily done by dragging the page
thumbnail images around, within the window. Changing the order of pages does not alter the
text in a story. The story remains intact even though text objects may have moved to different

pages.

I Sort Pages

@ Options. .. J Cancel
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USING THE FIND FEATURE

Using the find and change feature, you can search for specific occurrences of a
wont or group of words. Once you find what you’re looking for, then PageMaker automatically
changes it to the selected option. The find and the change dialog boxes can be activated from the
Utilities menu.

Find what; U ‘ IIl
Options: | Matchcase | Whole word M‘
Search document; Search story: %

 Curent publication (" 5elec

" Al publications * Cunent story
" Al stories

B Change E

Find what |\ | :l
Change to: | | i ‘
Options: |~ Matchcase | Whole word B
Search document: Search story: TR

{* Cument publication fi ‘

(" All publications * Cunent story w
(" Al stories Para attributes...

Working with Graphics and Layer

GRAPHICS

LINE TOOL

In this exercise, you will learn to use the Line Tool.
Select the Line Tool from the Tool Box.

Pointer the Cursor on “A” and hold down the mouse Button and drag it to Point
“B” and the release the mouse Button.
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Now you can see a line drawn on the Screen.

> Adobe PageMaker 6.5 - [Untitled-1] (=1E3
a X

BOX TOOL

Box tool is used to draw both rectangles and squares. In this exercise you will
learn to use the Box Tool.

Select the Box Tool.
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Point the Cursor on A and hold down the mouse Button and drag it to Point B and
release the mouse button to draw a Rectangle.

¥ Adobe PageMaker 6.5 - [Untitled-1]

File Edit Lawout Type Element Ubliies Wiew ‘Window Help
A 1,0 1 3 g [

Now Draw a Square using the Box Tool. Point the Cursor on C and hold down the
Shift Key and drag the mouse button down to Point D to draw a Square.

B

3
X

¥4| Adobe PageMaker 6.5 - [Untitled-1]
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ELLIPSE TOOL

Ellipse tool is used to draw both Ovals and Circles. In this exercise, you will learn
to use Ellipse Tool.

Select Ellipse Tool.

Point the Cursor on A and hold the mouse button down. Drag it to Point B to draw
an Oval.

File Edit Layout Type Element Utiities Wiew ‘Window Help
qd 101 i E g g
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Now draw a Circle using an Ellipse Tool Point the Cursor on C and hold down the
Shift key and drag the mouse button down to Point D to draw a Circle.
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POLYGON TOOL

In this exercise, you will learn to use the Polygon Tool
Select the Polygon Tool.

Point the Cursor on A and hold down the mouse Button and drag it to Point B and
release the mouse button to draw a Polygon Tool.
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In the Polygon Setting dialog box, enter 40 for the number of Sides and press the

Tab Key.
Enter 30% for star inset and Press the Tab Key .Click OK.
Polygon Settings g|
Murber of sides: W Preview
iJ J _'| Cancel
Star inzet: W 4
o N O
In this way you can modify a Polygon in to a star having 40 Sides and 30% Star
inset. -
£ Adahe PageMaker 6.5 - [Untitled-2]
A[T]
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] i
ol®
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ROUNDED COLORS

In this exercise you will learn how to round the corner of a rectangle using
“Rounded Corners” option.

Select the Pointer Tool.
Click the Rectangle to select it

Click Element menu.
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Select Rounded Corners.

The Rounded Corners dialog box appears on the Screen. From this dialog box
select the last Option.

Ruuﬁded Corners &I

][] =

Cancel

(]|

Click OK.

Click anywhere outside the rectangle on the screen

£ Adobe PageMaker 6.5 - [Untitled-3] FEX |
File Edt Layout Type Element Ublities Wiew ‘Window Help -
R N I I I [

You can now see the change in the corners of the rectangle. You can also modify a
square in the same way.

FILL

The Fill command is used to fill the box or circle with the options available under
this command, which consists of various types of lines along with the options like paper and
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solid. If you choose the paper option, the object fill changes to the background paper color and
when the solid option is chosen, the object gets completely filled

STROKE

You can use the stroke command to select the lines of different sizes and styles or
choose the option called custom to create the line of your own style. Besides these, you have
two more options called. Transparent and Reverse. Use Transparent Background option if you
want the objects placed behind a patterned stroke to be shown through the spaces in the pattern
otherwise the spaces in the pattern are opaque. Reverse Stroke option is used to draw a paper-
colored stroke or outline of a shape on a contrasting black, shaded, or colored background.

CCustern...
Morne
Hairline
5Spt
w 1pt
2pt
Apt
Gpt ———
Bpl I
12 pt I
qpt
H5pt ————
Spt
Gpt

w Transparenkt
Rewverse
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FILL AND STROKE

This is the combination of the above two commands. Instead of selecting them one
by one, you can select them together with this command.

Fill and Stroke

it MEGEE

ERIEN
Calor IBIue LI Calor ‘EIue .1] Cancel

Tk (100 = % T 100 | %

[ Derpint | Overprnt

W Transparent background

| Reverse

PLACING GRAPHICS

The Place command is used to Import Graphics. In this exercise you will learn
placing a Graphic. To do this you first click the File menu.

Select Place from the drop down menu.

The Place Dialog Box opens up. Double Click “Bouquet.tif”.

Lok iry | < Local Disk [C:) | cF BB
[ Acrobat3 C50FT
i’{‘ﬂDocuments and Settings i}-'jTC
) Inkel Cviden
CIKPCMS (L) WINDOWS
CPMes &) 20
(51 Program Files

Filz name: ]
Files of type: ]Importable Files j Cancel
Kind: |
Size: J Last modified: Place LURL...
Flace ~ Optionz - 1
& A3 new item I Show filter preferences [ Comverl qualtes
{~ Replacing entie stony ¥ Retain foimat I Readta
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You can now see the imported image on your screen.

| Adobe PageMaker 6.5 - [Untitled-4]
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TRANSFORMING OBJECTS

TRANSFORMING A RECTANGLE
In this exercise you will learn to transform a rectangle.
Select the Pointer Tool.
Click the Rectangle to select it.
Now you can see the change in Control Palette at the bottom of the work area

using which you can transform the rectangle. In the Control Palette change the Rotation to 25
degrees and press the Tab Key.

@ M %[6.935in__ | [AMwW5125in__ [100% EE & [25° F+1
EEY[5.594in | EFH4.03 in  [100% EE+ [25° F-H

Change the Skew angle to 25 degrees and Press the Tab Key. Click the width
column

@ (M |6.935 in EEwW5125in__ [100% EE & (25 1
EIFY [9.594 in EEIH [4.031 in_ [100% Bl (25 |52
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Change the width to 5 inches and press the Tab Key.
IEI Gl % [6.935 in GIE s, in 1003 EF & 257 F+7
EIEY [5.594 in EIFH [4.031 in 1003 B 257 L

Change the height to 5 inches and press the Tab Key.

B [5.594 in EIFH [ 5] 100 Bl [25* L

i @ EH%[6.935 in_| OHwW5E_in 100% B BB & P5 25

Click the Apply button.

You can now see the transformation in the rectangle. In the same way you can
transform any object using the control palette.
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RESIZING AN ELLIPSE

In the exercise you will learn how to resize and ellipse.

Select the Pointer Tool.

Click the ellipse drawn with the Pointer Tool and select it to display the sizing
handles.
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Click and drag handle shown to increase the height of the ellipse.
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CROPPING AN IMAGE

Cropping trims away a portion of the graphic, rather than reducing the size of the
graphic. In this exercise you will learn to Crop a Graphic.
Select the Cropping tool.
Click the Graphic to select it and display the Sizing Handles.

Click the handle shown and drag towards the center to crop the graphic.

Now click on the center of the graphic, notice that the cropping tool changes to a
hand tool. Hold down the mouse button and move the graphic downwards.

WORKING WITH COLOURS

ADDING COLOR TO A GRAPHIC SHAPE

In this exercise you will learn to add Color to a Graphic Shape.
Select the Pointer Tool.

Click the Polygon drawn on the Work area using the Pointer Tool to select it.
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Click Window menu.
Select Show Colors to open the Colors Palette.

While the Outline of the Polygon is still selected, click the stroke Button.
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Click Green color in the colors palette.
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You can see that the Outline of the polygon is changed t Green color. To Fill the
Polygon with yellow Color, Click the Fill button in the color Palette.

Click Yellow Color in the Color Palette.

Now you can see that the Polygon is filled with Yellow Color. Click the Tint
button to display the drop down tint list.
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Tint the fill Color to 55%by selecting it form the drop-down Tint list.

[ Styles | Colors™, >
|:||:| Tint;
[JrPaper]

[Black]
Il [Registrstion]

| S

[ cyan

.E.Green i

[l Hagenta 2E
I Fed mE
[ Wellows EE

-
X 0:0:0:100 [T & |

In this way you can easily add color to the Squares, Rectangles, Ovals and Circles
in PageMaker.

WORKING WITH COLORS

You can customize a color by using three color models i.e., RGB, HLS (hue,
lightness, and saturation mode) and CMYK provided by Page-Maker. RGB is used to blend

53



percentages of red, green, and blue. HLS is used for increasing or decreasing the lightness and
saturation of the hue as percentages of 100 to create the color. Using CMYK you can mix four
primary colors cyan, magenta, yellow, and black in varying percentages of 100 to get different
color combinations. All this can be done by selecting the new color icon at the bottom of the
color palette or by selecting new color form the color palettes fly-out menu.

Color Options

Mame: ||3|u,3 =
Twpe: [Spot =] Cancel
Maodel |RGE - Ch5 Source...

il

o Dveribraries: |

Red: i 248 ﬂ »

Green: ,D_ 1 ﬂ

Blue: 128 ﬂ J ﬂ
CMS Info

CHS iz cumently off. Thiz color uses: Mone.

CREATING AN RGB COLOR
In this exercise, you will learn to create an RGB Color.
Click the Color Palettes fly-out menu.

Select New Color...Option.

[ Styles | Colors™, >

[Fmm T |

[ tPaper] 2
-[Black] EE

Il (F=gistr aion]

I Bue
B o =E
Eﬁreen 1 | =]
.Magenta XE
- e
[ eltow [Fafis)

—

I 00255 [ [@ [~
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Mesw Color,,
Delete "Blue"
Duplicate "Blue"

Color Options, .,
Convert to Process Color

Import Colars, .,
Remove Unused Calors

v Display Color Model Icons
v Display Color Type Icons

The Color Options dialog box appears on the screen. Here you can see text boxes
of three different Colors, and Slide bars to enter Values for Red, Green, and Blue. Enter “250”
fro Red and press the Tab Key. Click the green dialog box.

Color Options

= G
Type: |Spot = Cancel
Model: |RGE - CHS Source...
[~ Overprint Libraries: | L]
Fed: 4 _DJ
Green: |40 ;] J _)]
Blue: 57 ﬂ J _‘)_]

-CM5 Info 1

CMS iz cumently off. Thiz color uses: Hone,

Enter “60” for Green and press the Tab Key. Click the blue dialog box.

Color Options

Mame: |
Type: |Spat = Cancel
Model |RGE - CMS Source...
I Overprint Libraries: | Li
Fied: [250 A »
Green: | L]_] j
Elue: 57 _ﬂ _] _»]

-CMS Info

CHE5 iz currently off. This color uses: None.
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Enter “160” for Blue and pres the Tab Key.

Color Options

Mame: | ar

Type: |Spat i 1 Cancel
Model |RGE - CHS5 Source
I Owerprint Libraries: | _:J
Red: |250 4 »
Grest: [€0 ‘:_J _] __’._.J
Blue: 4 1 _b_J

- CMS Info

ChS iz currently off. This color uses: Mone.

You can see a preview on the Right-Hand side of the dialog box, showing the
resulting color in the top half and the original color setting in the bottom half. Enter “Pink” in
the name dialog box and press the Tab Key.

Color Options

Tupe:  |Spat - Cancel
Madel: |RGE - ChS Source...
I Diverprirt Libraries: 1 _v_]
Red: 250 A »
Green: =0] _1_] __J d
Bl 160 it 5

-CMS Infio-

CMS iz currently off. Thiz color uges: Mone.

Click OK.

You can see that the name of the Color created is displayed in the Colors Palette

Colors ! [ k|
[~[m[a] T
. [Peqistration] 2
| S [FT=
..Cgan IZ]@
[ Green "=
. kdagenta ] |
[ pink !I§I
' - Red mo
O vellew ]
=
El Z50:60: 160 [& @& [
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EDITING, COPYING, REMOVING AND REPLACING COLORS

Editing: To edit a color, double-click on it in the colors palette. This opens up

the color options dialog box. In this box change the values for the color and in the Libraries list
box select the matching system you like. Click OK.

Copying: To copy a color from one document to other you can use Import Color
option from the color palettes fly-out menu.

Removing: To delete a color, select the color and use Delete option from colors
palette’s fly-out menu.

Replacing: To replace a color first you select the color you want to replace and
choose color option from the colors palette fly-out menu then you change the name of the color
to the exact name of the color you wish to replace it with and click OK.

Mew Color,.
D E Delete "brown"

g Duplicate "brown"
M (Fei

. Elue Color Options. ..

m Convert bo Process Colar

W Impark Calors.,,,
yan
Remove Unused Colors

. hage v Display Color Model Icons
v Display Color Type Icons

[ pink: ]
I Fed mE
[ wetlow [ ]
I z500600 160 [E [ & |v
REPLACING COLORS

In this exercise you will learn how to replace a color.
Select the “Red” Color in the Colors Palette.

Colors ! |4
Dn Tint:
. [Registration] ]
. EBlue

browen
. Cyan
D Graen
. bagenta
. pink
[ Red
[ vetlow

I 250:60:160

57



Click the Colors Palette fly-out menu.
Select Color options from the colors palette fly-out menu.

Enter the name of the Color to the exact name of the Color you want to replace
with. Enter “Green” in the Name dialog box and press the Tab Key.

Color Options

X]

Tupe: [Spat = Cancel
Model: |RGE - CMS Source...
[ Owerprint Libraries: | .j
Fied: ]ﬁ _ﬂ »
Green: ,T i]_j _)]
Blue: Fj?— ﬂ _J _p]

CMS Infia -

CMS is cumently off. Thiz color uses: Mone.

Click OK.

A confirm dialog box appears on the screen. Click OK.

Now you can see in the Colors palette that there is no Red color option since all
the items in Red are changed to Green Color.

Colors ™. Ll

EEE Tin: |

| [ 1Paper] ~
Il (BT EE
) [ ] [ Registration] j
-B1ue =
--..Cgan m@
| B Hagenta EE
M Red =
| O vettow e

~

I 0:255:0 [R & ] -

GROUPING AND UN-GROUPING OBJECTS
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Grouping is usually used to create shapes by combining different shapes and for
working on multiple objects at the same time. In this exercise you will learn to group the
objects.

Click Edit menu.
Select the option “Select All”.

Now you can see that both the Rectangle and Oval drawn on the Work area are
selected. Click Element menu.

£/ Adobe PageMaker 6.5 - [Untitled-5] (=1
@ File Edit Layout Tvpe Element Ukiities View ‘Window Help o |G e
[-E-Iq‘I|I3‘I|I2|I|I1‘\|I0|I|I1|\|I2|\|I3|I|I4|I‘Isll‘I5|I‘5\7|I|I8|I|\9|I|10 |I’I |I’2 |II‘
o

=

=

-

ElEE

SR RN

= [Oo|l= § -

= EE

i

bE sl )
IS

i

i

= EE%[5594in ]

N IElek T :

4 [ 3

| il 5

Select “Group” option.

Now the objects are grouped and any change you make will modify both the
object. To check this you click the fill button in the colors palette.

Select Green color

You can now see that both the objects are in Green color. To ungroup the objects
you just have to go the elements menu and select “ungroup” options.
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You can lock individual objects in place in order to help preserve the design of
your pages through all stages of production. You can change a color or fill applied to a locked
object, but not its degree of rotation or its skewing angle. You cannot cut or delete a locked
object without unlocking it first, but you can copy a locked object; it will be pasted as an
unlocked object. The Apply button in the Control Palette appears gray when the selected object
is locked. The cursor changes to a lock icon when you try to move a locked item.

Element
Fill »
Stroke »
Fill and Stroke. .. “~U
Frame »
Arrange 13

Texk Wrap...

Sroup i

Lock Position

Unmask. She

Now point the cursor on the Circle and try to drag it. You won’t be able to move

the object since it is locked. To Unlock the Object you just have to select “Unlock™ option from
Element menu.
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MASKING OBJECTS

Masking is a way of covering part of an object so that only a portion of it appears
through a shape drawn with the rectangle, ellipse, or polygon tool. In this exercise you will learn
how to mask objects.

Select the Pointer Tool.

Click the oval drawn on the work area using the Pointer Tool to select it.

ol Wi & o E)E
@ File Edit Layout Type Element Utiities Yiew ‘Window Help - Ex
L T T T T e e PO O o P 1 ST B S Y

Exerctation

Wial enin

Drag it and place it on the text, which is already there on the work area.

Select both the text and the object. To do this click Edit menu
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Select “Select All”. Now you can see that both the text and the object are
selected.

Click the Element menu.
Select “Mask” option

Click anywhere outside the object in the work area.

¥3| Adobe PageMaker 6.5 - [Untitled-4]

T = -
ﬁ n
PEEEEEEEEEERREERET,
enin
“ rrrrrM
BIE £ % ;
e = i B
O &
& A
EIEE

3
il | | #

You can now see that only the text inside the oval is visible and that around the
oval has disappeared. Actually this command cerates a window sort of effect to see the text
through the graphic. You can also adjust what part of the text has to appear through the object
by moving the text with the Pointer Tool

i3/ Adobe PageMaker 6.5 - [Untitled-4]
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WORKING WITH LAYERS

LAYERS

In PageMaker 7.0 there is layers, which are normally only found in high-end
graphic packages. This allows you to organize your document into a series of overlapping
layers, controlling their stack order, appearance and locking preferences.

USING LAYERS

In this exercise you will learn to use Layers.
Click Window menu.
Select Show Layers.
Click Layers palette fly-out menu.

Select “New Layer” option.

| Layers™ Master Pages

O [Default]

Default targeted Bl |

Mew Laver...

Lawer Options, ..

Paste Remembers Lavering
Seleck Targek Lawer

New Layer dialog box opens up. Click OK.
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Name: {Layer 2 0K |

k

Cancel

W Showlaper | Lock layer

The New Layer added is displayed on the Layer Palette with Green Color icon and
the name Layer 2. Click the Layers Palette fly-out menu.

w® W [Dafault]

Layer 2 targated B | T

Select “New Layer” Option.

Mew Layer,,,
Layer Options...

Paste Remembers Layering
Select Target Laver

New Layer dialog Box opens up. Click OK.

Mame: |Layer3 DKRA |
Calor: I-TLI Cancel

v Showlayer | Lock laver
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The new Layer added is displayed on the Layer Palette with Blue Color icon and
the name Layer 3. Click Layer2.

& O Layer 2
w W [Default] k

Layer 3 tarqeted B | T

Click File menu.
Select Place from the drop down menu.

The place dialog box opens up. Double-Click “Bouquet.tif .

e

Look in: | =5 PMBS x| % E-
[CDEXTRAS
[ERrsRe
|[E)zn
|l paTETIME. TYM
| E] PMssRES
?@Readme
Filz name: ] Open |
Files of tupe: IImDortabIe Files LI Cancel
e | e
Size: Last modified: Place LURL...
— Place < Options =

e Az new item I Show filker preferences & Coruert quotes

= Heplacing entire story = Eietair format [T FBeadtags

Move the Pointer to the Work area and Click it.

You can now see the imported image on your Screen. Now click on the icon
showing an eye next to Layer2 to hid the Layer.
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f baster Pages

[ Layer 3
H Layer 2
B [Default]

Layar 3 targated
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Click Layer 3.

Lagers‘[ Mazter Pages ™, b

i W Layer 3

- B [Default]

Layer 2 targeted Bl | T

- Select the oval tool.
- Click Element menu.
- Select Stroke.
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= Hairline
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[ = Spt—m—

e s 1pt — Arrange

= 2pt ian Slbjeck S
= Text Wrap... Alt~E
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Image
Palygon Settings...
Rounded Corrers...

Link Options. ..

Window

Stykes ] Calors ™

[Registration]
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- Select 6pt.
- Draw an Oval.

- Now select the Text Tool.

#% Adobe PageMaker. 6.5 - [Untitled-2] |
File Edit Layout Type Element Ukilities Yiew ‘Window Help = e
z 1

E Layer 2
il B [Default]

Layer 3 targeted Bl || |

Styles '*| Colors ™, »
EEE =[]
- @ [Mane] 5

0

. [Paper]

Wzss255255 0 | & | 0 |

[+ ll < | | 38

File Edit Layout Type Element Ukilities Wiew Window Help - & %

4 3 . of 1 4 = I i keI 11 B B

{ ] Lagers™( Master Pages ™
| & ] Layer 3
| & Layer 2

Happy | |m [Defau].t]

| Layer 3 targeted B |@ |

| Styles '*| Colors ™,

4

[Black] ~
. [Registration] "
| Eoooioo (& [ & |2
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- Type “New” and Press the Tab Key.
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- Select the entire text using the Text tool.
- Select Blue color from the colors palette.

i3 Adobe PageMaker 6.5 - [Untitled-2]

File Edit Layout Type Element Utilities Wiew Window Help =
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i Waster Pages
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Click anywhere Outside the Selection.

Unhide Layer 2.

T O Layer
i W [Default]

‘ Layer 3 targeted B | o

Now from this exercise you learn to place text and graphics together using Layers.

W7 Adobe PageMaker 6.5 - [Untitled-2]

File Edit Layout Type Element Utilities View Window Help
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hlasker Pages
A (] Layer 3
o Layar 2
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MOVING OBJECTS BETWEEN LAYERS

In this exercise you will learn to move objects between Layers.

Click Layer 2.

- - L -

Lagers{ bdaster Pages ™. »

= B Layer 3

o B [Default] W

Layar 2 targeted [=1] i
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Drag it on top of Layer 4 and release the mouse Button. Now in the Work area you
can see the Red Circle in Layer 2 coming in front of all other objects.

Lagers{ baster Pages ™. »
] B Layer 4 k

w B Layer 3

-3
i M [Default]
Layer 2 targeted [=1] i)

Select Layer 4.

L W Layer 4 W

% B Layer 3
B [Default]

Layer 2 targeted Bl | @

Now hold down the shift Key and select Layer3.

- LY n n

Lagers"[ baster Pages ™. »

=33 O Layer 2

=33 B Layer 3 k
W [Default]

Layer 4 targeted B | @

Drag both the layers on top of Layer 2.

Lagers“[ Master Pages ™, »

m O Layer 2

W [Default] k

Layer 4 targeted B | @
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Now again you can see the red circle going back of other objects. In this way you
can move the objects between Layers.

I.agers"[ blaster Pages ™,

- B Layer 2
O Layer 3
W [Defaul]
Layer 4 targeted IERER
LAYER OPTIONS

The Layer Options dialog box can be used to rename the layer select the different
color, show/ hid layer and lock/unlock layer. When you use show/ hid option the objects in that
particular layer will be hidden/ shown and when you use lock/ unlock layer, the layer gets
locked that is you will not be able to work on that layer. To do this you have to first click on the
layer you want to work on and then select Layer Options from the Layer palettes fly-out menu.

Layer Options E|

Marne: |DEfau|t oK

Calar; - Black = Cancel

v Show layer [ Lock layer

STACKING ORDER

Stacking is used to arrange a number of objects overlapping in the same Layer.
There are four ways of stacking objects, they are Bring to Front, Bring Forward, send back ward
and Send to Back. Bring to front moves the object in front all the objects. Bring Forward moves
the object one position toward the top of the stacking order and Send Backward moves the
object one position toward the bottom of the stacking order. To do this select the object you
want to move and select the option you like from the Arrange drop-down menu.
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Fill »
Stroke »
Fill and Stroke... ~U
Frame »
lign Objects Sh Bring Forward  Sh™]
Text Wrap... ale~E Send Backward  Sh[
Send ko Back b
Group i3
Lock Position e

USING PHOTOSHOP PLUG-INS

Photo Shop Plug-ins are used to give special effects to the graphics. In this
exercise, you will learn to use Photoshop Plug-ins.

Select the pointer tool.
Select the image on the screen using the pointer tool.

¥ hdobe PageMaker 6.5 - [Untitled-2]

File Edit Layout Type Element Utilities View SWindow Help L
T O O O B OO B B X B - B

| i
Click Element menu.
Select Image.
Select PhotoShop Effects.
|
CMS Saurce...

] Polvgon Settings. ..
Rounded Corners...

Photoshop Effects...
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The PhotoShop Effects dialog box opens up. Enter “New” in the Save New File as
dialog Box and press the Tab Key.

Click the Photoshop effects drop-down list.
Now from the PhotoShop Effects drop-down menu. Select “Glowing Edges”.
Click OK.

The Glowing Edges dialog box appears on the screen. In this you can see the
preview of the changed image. Click OK.

K5/ Adobe PageMaker 6.5 - [Untitled-1] FEX
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You can now see the difference in the image after giving the PhotoShop Effect. In
the same way you can change your image in many ways by selecting different effects from the
Photoshop Effects drop-down list.

Importing Text Features

IMPORTING TEXT FEATURES

HTML

When you import a HTML file, HTML format is mapped to PageMaker styles,
hyperlink information is retained; graphics are imported as inline or independent.
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MICROSOFT WORD

When text is imported from a word document table of contents, index, character
spacing, width, kerning, and tracking, page breaks tables and source of style is also imported
into the publication.

@ Document? - Microsoft Word

! File Edit Miew Imsert Formatk  Tools  Table  Window  Help

NBSERASRITERILBEI o E

i TimesMew Roman” = 12 = | B £ O |§ [

(6 Al Eritries + | g, E

- =

EI"f'g"""'l"""'z"'""3"""'4"""A'
Word descnption

2D (taro-dimensional) An object with tero dimensions
3D (thiee-dimensionall  An ohject that exists m and depth

= o]

: Loceleratortable  Files that cortain bists of shoxt &
= Speed up, or“accelerate,” aditing tasks. Different tab ou’re domg. @

R For example, when ywon highlizht text the | T
=sE]=wx i | >
Page 1 Sec 1 11 AL 22" Ln 7 Cal 42 SR E|

PAGEMAKER 5.0-6.0 STORIES

When you import publications from older versions of PageMaker you can place
selected stories as one list stories only over a specified length and preview the story.

¥2 Adobe PageMaker. 6.5 - [Untitled-2] <]
File Edit Lavout Type: Element Utilities. Wiew wWindow Help — A X

4 3 1 1l 1 3 4 £l 6| g IR TR R TN 1
'|I|||I|||I|||I||||2|||I||| i l.._.A

TEXT-ONLY (ASCII ANSI)
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When you import text from text files have the option of removing extra carriage
returns between paragraphs, retain tab-delimited tables, replace spaces with tabs, import text as
Courier and import text with no conversion.

8 Untitled - Notepad [ ”E”E'

File Edit Format Yiew Help

Access Time The time required to tetrieve a
data frim the computer memory.

Adress A unique representation fo a memeoy locati
Address bus A set of wires used to transmmit
Address. One wire is used for each bit in the adc
Algorithm represents a sequence of previsetatior
instructions to slove a problem.

ALY  Arithmetic logical unit of a computre what
performs artimetic and logical opertions.

Applet A SHALL CODE FO jawa program embedded in t
document .

ASCII ameieicam standared code for information
Interchange. This code is a string of seven bits
Icude character.

£ ¥

Ln 14, Cal 16

IMPORTING HTML FILES

- Select the Text tool.

- Click on the page where you want to insert the imported page.

- Click File

- Select Place from the File Menu.

- The Place dialog box appears. Select the ReadMe.html file to import.
- Click Open to place the document.

Look, in: l 15 PMES

iﬁExmns [Freadme
[CIRSRC

[Fz0

DATETIME, M

|'§:| document

[Z] PMESREG

Files of tupe: ]Importable Files L] Cancel
Kind | Ll

Size: ] Last modified: I Flace URL..
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IMPORTING SPREAD SHEET

If you are using a spreadsheet application that supports object Linking and
Embedding, you can link or embed an entire spreadsheet, a specified range, or a graphic. You
can also import a text, space or tab delimited form of a spreadsheet, and then format and edit it
in PageMaker. PageMaker has a limit of 40 tabs per paragraph and use tabs to separate
spreadsheet columns.

IMPORING PHOTO CD

The Kodak Photo CD is a standard for importing images.. When you import a
Photo CD image, the filter takes into account both image size and the resolution you specified in
the Document Setup dialog box, and then assigns the optimum default resolution.

IMPORTING QUICKTIME MOVIE FRAME

PageMaker allows you to import any frame of a QuickTime movie into your
publication as a linked TIFF image. By default the frame is imported in RGB color format at a
resolution of 72 dpi. When you export the file to PDF or to a HTML format, the output file will
include a link to the QuickTime movie.

ACQUIRING A TIFF IMAGE

76



PageMaker supports TWAIN, a cross-platform interface that lets you create a
TIFF image, using a device such as a scanner, video-capture board, or digital camera attached to
your computer and imports the image into your publication without leaving PageMaker.

OBJECT LINKING AND EMBEDDING

Object linking and Embedding is a standard for exchanging data between
applications. PageMaker can import OLE objects from other applications. You can link and
embed any objects as long as the source application supports it.

MANAGING LINKED FILES
LINKS MANAGER

There are three commands in PageMaker, which allow you to manage links. The
Links Manager command lets you view or modify links for single and multiple objects
throughout a publication.

Links Manager

IIE

o<

Docurrcrt

e
JEG: NGE

Opticrs.

Unlrk

Lt

Statuz: ~his iberr is L 1o date

LINK OPTIONS

The Link Options command or option lets you view or modify updating options
for an individual object or for link defaults.

Link Options

File: 20JPG
v Staore copy in publication
Cancel

Iv Update autamatically
[v flert before updating

LINK INFO

The Link Info command r option lets you view or modify a selected object’s link
to its original file.
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Link Info: 20.JPG

Loak in: | <e Local Disk [C:) - - =5 EF-
[ Program Files [
CSoFT &5 indiaz
e
[Chvideo
| [ WINDOWS
i.,:. PMES |55 _we__o03
IE3 | * |
File name: e lcom S Open I
Files of tupe: JAII Files - Cancel
Link Information
Location:  [C:A20LUPG
Kind: |IFEG: RGE
Size: a4k Placed: [1/1/2003. 12:38 &AM
Document modified:  [4/28/2005_12:29 At
Internal copy modified:  |Ma
I+ Fetain cropping data

EXPORTING OPTIONS

PageMaker can export text in several file formats, listed in the Export dialog box.
The formats listed are used by other applications, which retain the type specifications, indents,
and tabs set in your document. In addition to the already listed export formats PageMaker files
can be exported in either RTF (Rich text format) or DCA/RFT format. Rich Text Format retains
the most formatting. If Your word processing application doesn’t support these formats, use the
text-only (ASCII) format.

Export HTML x)

HTML Document Title Contents: PageM aker Pages Export HTML

Untitled1 Page 1 Done
Cancel

Edit...

Options...

Expoit Files To Location

Document... | D:\Wallpaper\Flowers\untiti2 htm
Graphics... | D:\Wallpaper\Flowers\ @

Background: ™ No background graphic is chosen =

-

EXPORTING TEXT

Click on the text frame.
Click File.

Select Export
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Select Text.

Arcquire L
Export... Adaobe POF...
1 HTML...

Links Manager...  sh~D

Graphic...,
Document Setup,..  Sh™P -

Prinker Styles 3
Prirk... ~p

The text export options dialog box appears. Enter “document” as a filename and
click the save as type drop sown box.

¥

Export Document E'[g'
Savein: | () PMES =li& cf E2-

\CIEXTRAS
CDRSRC

File name: ]Documents
Save az lupe: J WwhordPerfect 5.0/5.1 Cancel I
£ DCA/RFT
Hpart Rich Test Format
" Erttire stol_Tagged Test bgs
Text-only |
WordPerfect 5.0/5.1 = - -
o

In the Save as type box select Text only.

Click Save.

The story is saved in the text only format in the specified file.

EXPORTING GRAPHIC

You can export almost any kind of imported graphic in a publication in any one of
four formats: TIFF, JPEG, GIF89, or DCS. This section explains how to export graphics for
general purposes, but note that PageMaker includes export features designed for special
publishing tasks; exporting graphics for color separation purposes, or exporting a high-fidelity
color image foe editing in Adobe Photo Shop.

EXPORTING TO JPEG FORMAT
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Select a graphics to export

| Adobe PageMaker 6.5 - [Untitlad-1] 1%
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- Click File.
- Select Export.
- Select Graphic.

Type the file name as “Graphicl.tif” for the exported graphic and Click the Save
as type pop-up menu

Export Graphic il
Save in |'\‘;)F\Uwals lJ 4 cF E-

i\?ﬂflowers
|EEiMew Folder

File name: | Save |
Save ag tppe: |T|FF j Cancel

Graphic name: [435.JPG Reset ]
Farmat |JPEG

Settings...
Kind: |RGE
SOURCE SPACE is PageMaker 5.0 RGE Source # | [ Save for separation
emulation ver 1.0 [C] Coppright Adobe Corp. A
S v

™ Save ciopped area

™ Link to new image

™ Save cument settings as defaults

- From the Save as type pop-up menu select JPEG.



Click the Settings button

e A
Savein |\_’? Flowers j 4 ck B-
| fiowers [Fs5s [ 132
| E3Mew Folder 55 11423_walpaperasn | 1320
| B 1s [#1)25181_wallpaper2an [ 1320
| B3 | 37500_walpaper2a0 |&] 1320
| [ 435 ] ® 133
||&] 495 5 =% 7] 1331
| C Export JPEG options 132
| i | ¥
_ | Image Quality ‘ngh ﬂ 0K | =
File: name: 5
Fesolution: |Image _Y_J Cancel

Save az lypg el
Graphic h. - &
Format: JJPEG

; Settings.
Kind [rGE
.SDUHCE SPALCE iz PageMaker 5.0 RGE Souwce Al [ Save forsepas
emulation ver 1.0 () Copyright &dobe Corp.
1985 @ I Embed proth

™ Save cropped arsa
W Link to new image

W Save curent settings as defaults

The Export JPEG options settings dialog box appears. Click the Image Quality
pop up menu.
In the Image Quality popup menu select Low.
Click the Resolution pop up menu.
In the resolution pop up menu select Screen.
Click OK.
Click Save.

;Fhe file is saved with the options you have specified.
Publishing and Printing
PRINTING YOUR DOCUMENT

PRINTER

Here choose your printer type if you have loaded the drivers for more than one
printer, other-wise the default printer, which you have selected is shown.

No of Copies: Choose the number of copies of each page you want to print.

Collate: This option collates the printed output. If you want to make 2 copies of
pages 1-5 then this command will print page number 1 to 5, 2 times over in a collated form.
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Reverse order: This is used to print in reverse order that is while printing 1 to 5
pages; it will print 5 to 1.
Proof: By choosing this option you can print the pages as lower quality proofs.

Pages: All’ will print the entire document and if you select Ranges, you can
specify the range of pages to be printed.

Book: this command is valid if you have the publications limed up in Book. The
options here are that you can print all the pages of all the publications in the book or choose
otherwise.

Print drop down list: ‘Both Pages’ is used printing a document on the front
and back at a time. ‘Odd pages’ is normally used to print all odd numbered pages first. Then
these printed pages can be printed on the other side also by putting them back in the tray and
giving ‘Even Pages’ option.

Orientation: This has two icons for Portrait and Landscape. Select the
appropriate icon.

Ignore ‘Non-Printing’: Click this if you want to print the non-printing
characters too.

Reader’s spreads: It allows for the evaluation of two-page spreads.

Percentage: Print Options can be opened by clicking options button in printing
your document dialog box

You can scale the pages to any size before printing.

Reduce to fit: While printing if the paper size is smaller than the page designed
by you, the Reduce to fit command enables you to print the document on the paper even when
the paper size is small.

Thumbnails: Are an easy way of looking at all the pages in a document, to see
the overall design theme. This is used to print miniature editions of the pages as icons with a
maximum number of 16 pages per sheet of paper

Duplex: Duplex can be used to print on both sides of the page during one pass
through the printer. This is a very handy feature if you need to print front and back originals.
The various options here are None, Short edge and Long edge.
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Options: Here are the various options, which can be printed on the page itself
that is the Printer’s marks and Page information. Tiling breaks up the ultimate size into smaller
pieces that fit on the page size specified in the page Setup dialog box. PageMaker sets an
automatic overlap of the tiles that takes into account the unprintable margin around the edge of
the page or you can manually set overlap, if you wish.

COLOR OPTIONS

Color Options can be selected by clicking the Color button in printing your
document dialog box. This gives control over handling color separations and printing color.

Composite: Composite is opposite of separations. When this option is selected
colors will not be separated instead they will be printed in place as either shades of gray or as
close approximations of the colors. To print colors on a color printer, click the Composite
button. If you are using a laser printer then, using this option you get shades of gray.

Print Colors in Black button: Makes all the colors print in shades of black
in the same-screened percentages acquired with process and spot separations.

Separations: When you select the separations button, the separations pop-up list
becomes active. This contains the process colors and any spot colors you have defined for this
document. From this, select the colors whose separations you want to print and click ‘Print This
Ink’ check box to add an X in the pop-up list. PageMaker only prints separations for the colors
with X’s in the Print column.

Print All Inks: This command is used to mark all the colors with X’s.
Print No Ink: This command is used to remove all the X’s in the list of colors.

All to Process: This command is used to convert all spot color separations
temporarily to process separations.

PUBLISHING ON THE INTERNET

CREATING A PDF DOCUMENT

If you’re creating a publication for distribution on the Word Wide Web, design it
for the screen and then use one of two ways given above to prepare the file for the Internet. Use
the File>Export> Adobe PDF command to create a PDF file that can be distributed
electronically across the Word Wide Web. PDF files can be downloaded, viewed and printed
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from several different platforms with the page layout and typography of original document
intact.

CREATING AN HTML DOCUMENT

Use the File> Export >HTML command to create hypertext-linked pages that you
can publish on the World Wide Web. If you select the Preserve Approximate Page Layout
option in the Export HTML Options dialog box, PageMaker uses HTML tables to replicate the
design of each exported page, including the number and width of columns, and the size and
position of graphics on the page.

Export HTML

HTHL Document Title Contents:

Fpi
Untitled! ml
G|

Options...

PUBLISHING A DOCUMENT ON THE NET

PageMaker is used to create documents that can be published on the World Wide
Web. You have to first covert the file into ODF or HTML format, to do this click File menu.
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Select Export.
Select HTML.

The Export HTML dialog box appears on the screen. In this click the file name on
the left. You can see the number of pages of the document is displayed on the right- hand side.

Bxport HTHL K
HTML Document Title Contents: #port ki i
Untitled1 Dane I

k
Cancel

New

I

Options...

4

Export Files To Location -

-

Background:

In this dialog box you can make the changes in the file using Edit and Options
buttons and also specify the location to which the file has to be exported using Export Files to
Location button. Click Export HTML

Export HTML X

HTHL Document Title Contents: PageMaker Pages Export HTHL
T —
Cancel

New...
Edit...

Options...

Export Files To Location

Document... | C:APME5%untit]_htm
Graphics... | C:A\PMB5 @

Background: ™ Mo background graphic is chosen ==

]

The file will be converted to HTML format.
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